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1 Onsoz
PCE Instruments’ten bir PCE-GPA 62 Pens Gl¢ Analizori satin aldiginiz igin ¢ok tesekkir ederiz.

Pens gi¢ analizéri (Grafik Gug Kalitesi Analizori) PCE-GPA 62, i¢ veya tek asamali aktif glii¢ 6lgim,
reaktif ve gorundr, gug faktorl, faz agisi, enerji, voltaj, akim, 50°lik harmonik dalga olusumuna kadar
tepeler ve harmonikler igin hizmet vermektedir. Pens gii¢ analizéri PCE-GPA 62’nin entegre grafik ekrani
dlclilen ideal degerleri gosterir. Olgiim degerleri kaydedilir ve daha sonra analiz igin PC'ye aktarilir. PCE-
GPA 62 profesyonel bir el cihazidir ve onunla birlikte birden ¢ok parametre belirleyebilisiniz. Aydinlatma
kosullari uygun olmasa bile ekranda ki arka isik sayesinde, de@erlerin dogru okumasini yapabilir.
Harmonik analizéri fabrikada kalibre edilir olmakla birlikte, istege bagh olarak ISO (yillik yeniden
ayarlama icin ilk istegi) kurallarina gére onayli ve laboratuarda ayarlama yapilabilir.

2 Guvenlik bilgileri

Cihaz1 c¢alistirmadan o6nce litfen kullanim talimatlarini dikkatlice okuyunuz. Bu talimatlar uygun
yapilmayan kullanimdan olusabilecek zararlardan bizler sorumlu degiliz.

PCE Teknik Cihazlar bu kullanim kilavuzu nedeniyle olusabilecek bitiin sorunlardan mesul degildir.

2.1  Kullanim Kilavuzunda Semboller

DIKKAT!
Kullanim Kilavuzu talimatlarina dikkat ediniz

DIKKAT! Elektrik carpmasi riski bulunmaktadir

Cift yalitimli

Tehlikeli elektrik ileten iletkenlerin yakinindaki kullanima ve montaja izin vardir

Topraklama

AC (Dalgali Gerilim)

DC (Duz Gerilim)

Diz- ve Dalgal Gerilim

Qi i E B B

c € Avrupa yonetmeliklerine uygundur
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Olglim Cihazini ev ¢dpline atmayiniz. Bu Kullanim Kilavuzunun son béliimiinde bulunan
Geri Gonlstim boélimUine bakiniz.

132

EN 61010-2-032
CAT Il 600V
Emisyon Derecesi 2

2.2 Asin gerilim Kategorisi

CAT I Gegici asin gerilimleri dusuk seviyeye sinirlamak igin 6nlemler alinmis devrelere
baglanan Cihazlar.

CAT Il Elektrik prizine bagh olan tek fazl yulkler. Bunlar ev aletleri, taginabilir aletler ve benzeri
ylklerdir.
CAT Il Tek fazli ticari aydinlatma dahil olmak Uzere Ug¢ fazli dagitim. Bunlarin icinde sabit montaj

icin Cihazlar, érn. gok fazli motorlar ve salt cihazlari, sayilmaktadir.

2.3 Glvenlik bilgileri

Sartlar ve kosullarda bulunan genel garanti kosullarina lutfen dikkat ediniz.

Cihazi asla 600 V Uzeri gerlimler i¢in kullanmayiniz.

Pensin Ust kismina dokunmayiniz.

Pensi veya ek 6geleri hasarli oldugunda kullanmayiniz.

Yuksek gerilimlerde asiri dikkatli olunuz.

30VAC RMS lizeri veya 60 VDC uzeri 6lgiimlerde dikkatli sekilde ¢alisiniz.
Acik iletkenlerde veya akim raylarinda asiri sekilde dikkatli calisiniz.
Olgtim Cihazini kullanim kilavuzunda tarif edildigi gibi kullanin.

DIKKAT: Olgiim iletkenleri iretici tarafindan tarif edildigi gibi kullanmazsaniz élgiim esnasindaki giivenlik
saglanamaz.

Sorulariniz i¢cin PCE Teknik Cihazlari ile irtibata geginiz
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3 Fonksiyonlar

Tekli ve simetrik 3 fazli sistemde gli¢ analizi

Akim ve gerilim analizi

0,5%’lik hassasiyet ile gerilimin True RMS 6lguimi

1%’lik hassasiyet ile akimin True RMS 6lgimd

Akim ve gerilimin grafik olarak goérintisu

Grafik fazor diyagrami

Girig, ¢ikis ve ara dalgalanmalarin tanimlamasi ve kaydi

Aktif Gug (W,KW,PS), Reaktif Gig (VAR,KVAR) ve Gorlinur Gu¢ (VA, KVA)
Glg Faktoru (cos @), Faz Kaymasi (¢) ve Enerji (Calisma)(Wh, kWh, KVARh)
Simetrik 3 ¢ gi¢ kalitesinin dlguimu

1 ... 3000’lik programlanabilir V/t orani

Hold Fonksiyonu

15 dakika sonra otomatik kapanma (secilebilir)

Bilgisayara yukleme ve veri kaydi

Olglim Cihazi ve USB Kablo arasi optik baglant

Bilgisayarda 6lgim verilerin sinirsiz kayit imkani

3.1 Teslimat igerigi

1 x PCE-GPA 62 Pens Gug¢ Analizoru,
2 x 6lcim noktalari yalitimli 2 m Kablo,

2 x Pil,

1 x tagima gantasi,

1 x Bilgisayar icin USB Kablosu,
1 x Yazihim (ingilizce)

1 x Kullanim Kilavuzu
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4 Cihaz agiklamasi

9.

CANCEL:$¢

hase, OFF
1Phase. 7

8
B

nnnnnn

alc

ADD

B

B)

600V MAX CAT lll

B

Pens Mekanizmasi

Akim Pensin agma digmesi

HOLD / CANCEL / Backlight — Bu Tus ile ekrani dondurabilirsiniz veya arka plan aydinlatmasini
acip ve kapatabilirsiniz. Ayrica bu tus ile harmonigin silinmesi icin kullanilabilir.

Secim Salteri — Segim Salterini 6lgim yéntemini segmek igin kullaniniz.
Arka plan aydinlatmali LCD — Nokta Matrisli Ekran

+ P Dugmesi — Degeri 1 ile artirin / Referans eksenini Ustte tasi / Cizgi kursérini saga
kaydirma / bir sonraki sonug i¢in bir sonraki sayfa

REC — Veri kaydini baslatmak i¢in bu tusa basiniz. Tekrar basildiginda kayit iglemi durdurulur.
Batun verileri silmek igin tusu basili tutunuz ve Cihazi aginiz. Ayrica bu tus ile diger dalgalari
konfigurasyonlara ekleyebilirsiniz.

- 4 Tus — Degeri 1 ile dusurin / Referans eksenini asagi tasi / Cizgi kirsérini sola
kaydirma / bir 6nceki sonug icin bir dnceki sayfa

FUNC Tus — Baska goriuntu elde etmek icin bu tusa basiniz.

10. V-Giris Yuvasi — Gerilim igin giris yuvasi

11. COM-Yuvasi — Kiitle ve referans girigi

12. RS232-Pencere ve Pil kapagi
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5 Kullanim Kilavuzu

5.1 Ayarlama

Kullanim Kilavuzu

Secim  Salterini  SETUP-Pozisyonuna geviriniz. Olglimden once gerekli 6lgim ayarlamasini

gerceklestirmeniz gerekmektedir.

Parametreyi secin

CANCEL %
W

2\ 60CY MAX CAT 1IH

Degeri yikseltin
veya azaltin

5.1.1 SETUP’da ayarlama imkani

Graphic Power Quality Analyzer

CURRENT TIME: Dahili takvim icin gincel saatin ayarlamasi
(H:MM).

SAMPLE: Saniyede veri kaydin ayarlamasi.

START TIME: Veri kaydi baslatma saati ayarlamasi (H:MM).
STOP TIME: Veri kaydi sonlandirma saati ayarlamasi (H:MM).

VT: Olgiim dénlisiim oranin (Standart: 1) ayarlamasi

V(okunmus) = Gerilim*VT

MD: MD (Maximum Demand) zaman aralhd 1 ve 60 dakika
arasindadir. Zaman araligi ayarlandiktan sonra Cihaz maksimum
guc kaydini ve ortalama gic¢ kaydini Watt (W) veya VA olarak
hesaplar.

HZ: Ag frekansin ayarlamasi (50Hz, 60 Hz veya Auto (Otomatik)).
AUTO POWER OFF: Otomatik kapanma ACMA (1) veya KAPATMA (0).
TRANS REF: Dalgalanma kaydi i¢in nominal gerilimin ve esik (%) ayarlamasi.



Kullanim Kilavuzu PC E Instruments

HARMONICS CONFIG: Hangi harmonidin kayit edilecegini
Graphic Power Quality Analyzer  avarlar.

CANCEL &
Dalgalan silin

—— Dalgalan ekleyin

2\ SOV MAX CAT 11}

Dalgalan secin

Not: Olgiim Cihazi tekrarlama siiresini ayarlanmig dalgalanmalarin sayisina gére uyarlar.

Graphic Power Quality Analyzer

WAVEFORM CONFIG: Her dalgalanma gorintisinin gegisinde

ka¢c nokta kaydedilecegini ayarlar. DOrt segenek ayarlanabilir:
32,64,128, 256.

Not: Olgiim Cihazi tekrarlama siresini ayarlanmis dalgalanmalarin
saylisina gore uyarlar.

10
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Graphic Power Quality Analyzer

DATE: Dahili takvim i¢in guincel tarih ayarlama imkani.
o Format: JJ:MM:TT (SS:AA:GG)

{50

5.2 Dalga Gerilimin RMS Deger, THD-F ve Harmonik él¢ciimu

CANCEL:$

=]

:iPhasehOF!=
S

5.2.1 Gerilim élcimu

1. Secim Jalterini ,V* — Pozisyonuna getiriniz.
2. Olglm iletkenlerini Olgiim Cihazindaki ilgili yuvalar ile baglayiniz (resime bakiniz).
3. Kontrol uglarini paral sekilde 6lgcmek istediginiz kontaktlara tutunuz

Not: Olgllecek gerilimin en ylksek degeri 6lgim araligini gegerse Olgiim Cihazin ekraninda ,OL*
gOruntulenir.

11
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RMS Deger % THD-F: Temel frekansin dogrultusunda harmonigin
mutlak ¢arpitmasi
Dalgalanma
VV22 + V32 + ... + V492 + V502
%THD — F = Vi +100

V1: Nominal Frekans’da deger (50Hz / 60 Hz)
V2: 2. (ikinci) dalgalanmada deger

(/.50: 50. (ellinci) dalgalanmada deger

Cizgi KUrsor—

12
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CANCEL %
HoLD

3 Phase
1 Phase .
7
Al
Translent «

SETUP

Not: Frekans iki sayfada gorintilenir (25 ve 50 arasi dalgalanma)

13
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5.3 Dalga Akimin RMS Deger, THD-F ve Harmonik 6lcimi

5.3.1 Akim Olgiimii

Secim Salterini ,A“ — Pozisyonuna getiriniz.

i_I.etkeni resimde gérdiguniz gibi pensin igine aliniz. Bu islemde akimin akis ydénine dikkat ediniz.
Olcim degeri ekranda goérintdlenir.

wnN e

14
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% THD-F: Temel frekansin dogrultusunda harmonigin

RMS Deger mutlak carpitmasi

VV22 + V32 + ... + V492 +V507?
%THD — F = Vi +100

Dalgalanma

V1: Nominal Frekans’da deger (50Hz / 60 Hz)
V2: 2. (ikinci) dalgalanmada deger

{/'50: 50. (ellinci) dalgalanmada deger

Cizgi KOrsdr —

15
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CANCEL %
HoLD

OFF

3 Phase
1 Phase .

vl -
Al
Translent «

SETUP

£\ 800GV MAX CAT (1)

Not: Frekans iki sayfada gorintilenir (25 ve 50 arasi dalgalanma)

16
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5.4 Cizgi diyagraminda faz a¢isi ile ACV ve ACA’nin goriintillenmesi

5.4.1 Faz agisi ile Akim ve Gerilimin goriintiilenmesi

Eger ACV'u ve ACA'I diyagramda goruntlletmek istiyorsaniz iletkeni pensin igine gegirmeniz (akim
Olciim) ve 6lgiim iletkenlerini kontaklara paralel bir sekilde tutmaniz (gerilim 6lgimi) gerekmektedir.

CANCEL

1 Phase .

vl -

Al -
Transient «

SETUP 33

Gostergeyi secin

)\ 600V MAX CAT 111

Graphlc Power Quality Analyzer
2° lead

Eger Secim Salterini diyagrami goster pozisyonuna getirdiginizde
Olgum Cihazi gerilimi, akimi ve faz agisini gérintuler.

100 0o Eger +»veya -« Tuslarina basarsaniz gerilim igin olan referans
. eksenini yukari veya asagi kaydirabilirsiniz. Boylece yandaki

resimde gorildigu gibi akim ve gerilimi daha kolay okuyabilirsiniz

s0] /. LY N /150

17
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5.4.2 Gerilimin gdrintilenmesi (ACV)

Graphic Power Quality Analyzer

199 Gerilim goruntisiini RMS-Degeri ve en yilksek deger ile
goruntilemek icin FUNC-Tusuna basiniz.

5.4.3 Akimin goriintilenmesi (ACA)

Graphic Power Quality Analyzer

Akim gorintisini RMS-Degeri ve en ylksek deger ile
=n 9goruntllemek icin FUNC-Tusuna basiniz.

5.5 Tek fazh gig¢ analizi

=]

Current

1. Segim Salterini ,1 Phase” Pozisyonuna getiriniz.
2. Olglm iletkenlerini tuketiciye paralel bir sekilde baglayiniz.
3. Tuketiciye giden iletkeni pensin igine aliniz. Burda akim akig yonine dikkat ediniz.

Not: Olgllecek gerilimin veya akimin en yiiksek degeri 6lgim arah@ini gegerse Olgim Cihazin ekraninda
,OL® goruntulenir.

18
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Not: VT-Orani 1 degilse gorintilenen deger 6lgilen deger (W, VA, VAR) carpi VT ile esittir.
Ormn.: Wicp= Wi")k; *VT

55.1 Glg (W) ve Giug Faktorld (PF) 6lcumi

5.5.2 Godrunen Gug¢ (VA, KVA) ve Reaktif Gi¢ (VAR, KVAR) dlcimu

5.5.3 Tiuiketilen Gug (kW, kVA) dlgcimu

Dikkat: Olgiim icin otomatik kapanma fonksiyonu devre disi birakmaniz gerekmektedir!

19
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5.5.4  Enerji (KWh, PFh, KVARh ve KVAh) 6lcimii

Dikkat: Olgiim igin otomatik kapanma fonksiyonu devre disi birakmaniz gerekmektedir!

5.5.5 Fazor Diyagram goruntisi

5.5.6 Akim ve Gerilimin RMS-Deger goriintiisii

20
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5.6

Simetrik 3 fazli ag’in él¢limii

e

]

S0

-
w

PobDE

56.1

Secim Salterini ,3 Phase” Pozisyonuna getiriniz.

Test iletkenlerini gerlimin kaynagina paralel bir sekilde L1 ve L3 arasi baglayiniz.
Tuketiciye giden iletkeni pensin icine aliniz. Burda akim akis ydnine dikkat ediniz.
FUNC tusuna basarak asagidaki goruntuleri elde edebilirsiniz.

Guc (W) ve Gug Faktoru (PF) 6lgimi

21
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5.6.3 Maksimum Gug¢ (kW, kVA) dl¢imi

Dikkat: Olgiim igin otomatik kapanma fonksiyonu devre disi birakmaniz gerekmektedir!

5.6.4 Enerji (Gahgma) (KWh, PFh, KVARh ve KVAh) 6l¢cimi

Dikkat: Olgiim igin otomatik kapanma fonksiyonu devre disi birakmaniz gerekmektedir!

5.6.5 Fazor Diyagram goruntisi

22
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5.6.6 Akim ve Gerilimin RMS-Deger goriintiisii

‘Graphic Power Quality Analyzer

6 Gerilimin (RMS — Deger) ve Harmonigin kaydi
6.1 Planlanmig kayit

1. Secim Salterini ,V* Pozisyonuna getiriniz

CANCEL %¢
HOLD

OFF

3 Phase
1 Phase .

vl -
All -

Transient -

Baslatma

/\ 800V MAX CAT IlI

23
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2. Eger ekranda agagidaki resmi goriirseniz REC tusuna basiniz ve Setup’da ayarlanmis tekrarlama
orani ile veri kaydi baglayacaktir.

Not: ilk RMS-Degeri ve ilk Dalgalanma her zaman kayit edilir.

3. REC tusuna bastiginizda asagidaki gérintiyu gorebilirsiniz

HOLD tusunu 2 saniye kadar basili tutarsaniz kayit islemini sonlandirabilmeniz i¢in 8 saniye

vaktiniz vardir.
HOLD tusu basiimadigi zaman kayit islemi baslatilir. Veri kaydi basladiginda baglanti yuvalarin

yanindaki LED yanip séner.
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CANCEL ¥
HOLD

OFF

3 Phase
1 Phase .

v llu -
All, -
Transient +

SETUP

Goriuntisuz

LED 15181

Baslangi¢ ve bitis zamanini SETUP’da ayarlayabilirsiniz.

6.2 Aninda veri kaydi

REC tusuna iki defa basiniz.
Baslangi¢ zamani otomatik olarak bir sonraki dakika icin belirlenir.
Bitis zamani sonraki giinde ayni saattir.
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7 Akimin (RMS - Deger) ve Harmonigin kaydi

7.1 Planlanmig kayit

1. SETUP’da baslatma ve bitis zamanini ayarlayiniz. Se¢im Salterini ,A“ Pozisyonuna getirinz.

2. Kayit igslemini baslatmak icin REC tusuna basiniz.

CANCEL 3¢
HOLD

3 Phase ot
1 Phase .
v lllm \’

Al -

Translent -

Baslatma

2\ 60OV MAX CAT NI
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3. REC tusuna bastiginizda asagidaki gérintuyu gorebilirsiniz

'rmeu $10

HOLD tusunu 2 saniye kadar basili tutarsaniz kayit islemini sonlandirabilmeniz i¢in 8 saniye

vaktiniz vardir.
HOLD tusu basilmadigi zaman kayit islemi baslatilir. Veri kaydi bagladiginda baglanti yuvalarin

yanindaki LED yanip soner.

CANCEL ¥
HOLD

3 Phase_°FF

1 Phase .

vl -

Al -
Transient -

SETUP

Goruntusiz

LED 1181
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7.2  Aninda veri kaydi

REC tusuna iki defa basiniz.
Baslangi¢ zamani otomatik olarak bir sonraki dakika igin belirlenir.
Bitis zamani sonraki glinde ayni saattir.

8 Gerilim ve Akim Diyagramin veri kaydi

8.1 Akim ve Gerilim 6zelliklerin kaydi

Secim Salterini Akim ve Gerilim diyagram goruntilenme pozisyonuna getiriniz. Ekranda akim ve gerilim
dalgalari gorintilenene kadar FUNC tusuna basiniz.
Veri kaydini baglatmak i¢cin REC tusuna basiniz. Simdi akim ve gerilim kaydedilir.

CANCEL %¢

HOLD
3 Phase e
1 Phase .

vl -
Al -

Transient -

SETUP OFF

Baslatma

N\ 600V MAX CAT It

Not: Kayit edilecek noktalarin sayisini SETUP’da ayarlayabilirsiniz.
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8.2  Gerilim 6zelliklerin kaydi

Secim Salterini Akim ve Gerilim diyagram goérintilenme pozisyonuna getiriniz. Ekranda gerilim dalgasi
goriuntilenene kadar FUNC tusuna basiniz.
Veri kaydini baslatmak igin REC tusuna basiniz.

CANCEL %¢

HOLD
3 Phase orF
1 Phase .

vl -
All -

Transient -«

SETUP OFF

Baslatma

Z/\ 600V MAX CAT Il

Not: Kayit edilecek noktalarin sayisini SETUP’da ayarlayabilirsiniz.
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8.3  Akim ozelliklerin kaydi

Secim Salterini Akim ve Gerilim diyagram gorintiilenme pozisyonuna getiriniz. Ekranda akim dalgasi
goriuntilenene kadar FUNC tusuna basiniz.

Veri kaydini baslatmak igin REC tusuna basiniz.

CANCEL %
HOLD

3 Phase_ OFF
1 Phase .

vl -
Al -

Transient -«

SETUP

Baslatma

£\ 800V MAX CAT Il

Not: Kayit edilecek noktalarin sayisini SETUP’da ayarlayabilirsiniz.
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9 Transient (Hata) dalgalanmalari veri kaydi
Secim Salterini ,Transient* Pozisyonuna getiriniz. Ekranda asagidaki gortintliyl gorebilirsiniz:

‘Graphic Power Quality Analyzer

Resimde 5%/’lik esik deger ile 110V’luk referansgerilimi (TRANS REF) gorintilenir.

Eger gerilim 115,5V (SWELL) asarsa veya gerilim 104,5V (DIP) kuguk ise veya 40V (OUTAGE) kii¢uk ise
hata kaydedilir.

Not: Maksimum 32000 kaydedebilirsiniz.

Hata dalgalanmalarin tanimlamasini baslatmak i¢cin FUNC tusuna basiniz.

CANCEL 3¢
HOLD

OFF

3 Phase
1 Phase .

Vi -
Alh.‘

Transient -«

Baslatma

/\ 600V MAX CAT Iil
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FUNC tusuna bastiktan sonra ekran temizlenir ve baglanti yuvalarin yanindaki LED yanip sdner.

CANCEL %
HOLD

OFF

3 Phase
1 Phase .

v -
Al -
Transient -

-

SETUP

Gorunttusuz

LED 15141
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PC E Instruments

Kayit islemini bitirmek istediginizde FUNC tusuna basiniz. +» veya -« tuslari sayesinde kayitlara tek tek

bakabilirsiniz.
CANCEL 3
HOLD
3 Phase
1 Phase .
Vi -
Al -
Transient -
Durdurma ve
goranta
/N 8OGV MAX CAT 11
ileri ve geri
Kayit No. Baslangic zamani
."'G,r‘aphlc ower Qujlity Analyzer
(DIP) : 2 |
Gerilim diisik ' Siire
(SKELL) | 1ize |
Gerilim yitksek £ 470 o
W1n28sec |
24CYCLE  Jo |
1 5§ 10 15 20 25
26 30 35 40 45 S0
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Kayit No. Baslangic zamani

y e

Graphlc Power Quality Analyzer
(DIP) S ?;_' erE |

Gerilim dusik /fLE Sire
ITAGE CUCLE
Gerilim < 40V ([)l T\(l[',) ?,ér /(L
NE COCLE
Gerilim yiiksek (SWELL) E egavr') AL
‘ , 7C'v‘f LE

10 Guciin veri kaydi

10.1 Planlanmis kayit

Secim Salterini ,3 Phase* Pozisyonuna getiriniz. Kayit islemini baglatmak icin REC tusuna basiniz.
Kayit islemini baslatmadan 6nce baslangi¢ ve bitis zamanini SETUP’da ayarlayiniz.

CANCEL %
HOLD

OFF

3 Phase
1 Phase .

Vi -
Al -

Transient »

Baslatma

/\ 800V MAX CAT 1!
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REC tusu basildiginda ekranda asagidaki resim goruntalenir.

‘Graphlc Power Quality Analyzer
1 : 2’30 100
| I 111530
18 sec to start i
b{jt’,l:vh Lo \ eSS HOLI’ !:")9."24" ) [
\ e JO

5 20 25
40 4 80

HOLD tusunu 2 saniye kadar basil tutarsaniz kayit iglemini sonlandirabilmeniz icin 8 saniye vaktiniz

vardir.
HOLD tusu basiimadi§i zaman kayit islemi baslatilir. Veri kaydi basladiginda baglanti yuvalarin yanindaki

LED yanip séner.

CANCEL 3%

vl -

Al *

Transiont +
N .

SETUP e

Gorantusuz

LED isigi

Olgiim Cihazi 50.000 Deger (Tarih/Zaman, VA, W, VAR, PF, KVAH, KWH, KVARH, PFH, AD(VA),
AD(W), MD(VA), MD(W), Phase (Faz), PS) kaydeder.
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10.2 Aninda veri kaydi

REC tusuna iki defa basiniz.
Baslangi¢c zamani otomatik olarak bir sonraki dakika igin belirlenir.
Bitis zamani sonraki glinde ayni saattir.

11 Dabhili ver hafizasinin silinmesi

Veri kaydedicisinin hafizasini silmek icin REC tusunu basili tutunuz ve Cihazi aginiz. HOLD tusuna
basarak hafizanin silme islemini onaylayiniz.
Dahili hafiza komple silindiyse Cihaz otomatik olarak kapanir.

Graphic Power Quality Analyzer

. HOLD button to
100f C10A" Menory 100
50
0

HOLD tusunu 8 saniye kadar basili tutmazsaniz hafiza silinmez. Bdylece hafizanin yanlishkla silinme
imkani ortadan kalkar.

12 RS232 Protokoll

Baud hizi: 9600
Veri Bit: 8

Stop Bit: 1
Parite: Hig
Format: ASCII

13 Ozellikler (23°C + 5°C)

13.1 Gig
Gug (50 veya 60 Hz, PF 0.5den 1.0’a kadar, VT = 1, Gerilim > 5V AC, Akim > 5A AC A araliginda, ve
surekli dalgalanma)

Aralik (0‘dan Cozuniirlik Olciimde Hassasiyet
1500A’e kadar) > 20V ve >20A <20V veya <
20A
10.0 - 999.9 W 0.1W +1% +20dijit +2% +40dijit
1.000 — 9.999 KW 0.001 KW +1% +20dijit +2% +40dijit
10.00 — 99.99 KW 0.01 KW +1% +£20dijit +2% +40dijit
100.0 — 999.9 KW 0.1 KW +1% +20dijit +2% +40dijit
1000 — 9999 KW 1 KW +1% +20dijit +2% +40dijit

'VT #1°de ¢oziindirliik yiizdelik olarak aynisidir (+1%). Giiciin ek bilgisi VT ile garpilmasi gerekmektedir.
Ornek: £0.2W = +0.2W * VT
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13.2 Gorunen Gilg
Gorunen Gug (VA, 0.000VA’dan 9999 KVA'ya kadar, PF 0.5’den 1’e kadar)

Aralik (0'dan Cozunarlik Olciimde Hassasiyet”
1500A’e kadar) > 20V ve >20A <20V veya <

20A
10.0 — 999.9 VA 0.1VA +1% +20dijit +2% +40dijit
1.000 — 9.999 KVA 0.001 KVA +1% +20dijit +2% +40dijit
10.00 — 99.99 KVA 0.01 KVA +1% +20dijit +2% +40dijit
100.0 — 999.9 KVA 0.1 KVA +1% +20dijit +2% +40dijit
1000 — 9999 KVA 1 KVA +1% +20dijit +2% +40dijit

VT #1°de ¢oziindirliik ylizdelik olarak aynisidir (£1%). Giiciin ek bilgisi VT ile ¢arpilmasi gerekmektedir.
Ornek: +0.2VA > +0.2VA * VT

13.3 Reaktif Gug
Reaktif Gu¢ (VAR, 0.000VAR’den 9999 KVAR’ya kadar)

Aralik (0‘dan Cozinurlik Olctimde Hassasiyet"
1500A’e kadar) > 20V ve >20A <20V veya <
20A
10.0 — 999.9 VAR 0.1VAR +2% +30dijit +3% +40dijit
1.000 — 9.999 0.001 +2% +30dijit +3% *40dijit
KVAR KVAR
10.00 — 99.99 0.01 KVAR +2% £30dijit +3% +40dijit
KVAR
100.0 — 999.9 0.1 KVAR +2% £30dijit +3% +40dijit
KVAR
1000 — 9999 KVAR 1 KVAR +2% £30dijit +3% +40dijit

'VT #1'de ¢oziindirliik yiizdelik olarak aynisidir (+1%). Giiciin ek bilgisi VT ile garpilmasi gerekmektedir.
Ornek: +0.2VAR - +0.2VAR * VT

VT (Volt Transformer) Ratio’nun arahigi: 1’den 3000’e kadar

Enerji (Calisma) (WH, veya KWH, 0 WH’dan 999.999 kWH’ya kadar)
Hesaplama: WH =W * Time (saat olarak)

13.4 Akim
Akim (50 veya 60 Hz, Auto Range, True RMS, en yiksek Faktor < 4,asir yiklenme korumasi 2000A)
Aralik Cozinurlik Olciimde Hassasiyet
4.0 —1500.0 A 0.01 A +1.0% =+ 5dijit
13.5 Gerilim

Gerilim ((50 veya 60 Hz, Auto Range, True RMS, en yiksek Faktér < 4,VT=1, Input Impedanz 10 MQ,
asir yiklenme korumasi 800V)
Aralik Cozinrlik Olclimde Hassasiyet”
4.0V -600.0V 0.1V +0.5% =+ 5dijit

YT #1°de ¢oziinirliik yiizdelik olarak aynisidir (+1%). Dijitlerin ek bilgisi VT ile ¢arpiimasi gerekmektedir.
Ornek: +0.2dijit = +0.2dijit * VT
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13.6 Yuzdelik olarak gerilimde harmonikler

Yuzdelik olarak gerilimde harmonikler (1’den 50’ye kadar dizen, 50 Hz veya 60 Hz'de minimum gerilim
> AC 80V. Eger 50Hz’de gerilim 0V ise 0% goéruntilenir.)

Aralik Cozindrluk Hassasiyet
1-20" 0.1% +20%h
21 -50" 0.1% okunan +2.0%‘nin 4%

13.7 Mutlak deger olarak gerilimde harmonikler
Mutlak deger olarak gerilimde harmonikler 1’den 50’ye kadar diizen, 50 Hz veya 60 Hz'de minimum

gerilim > 80V, VT=1)

Aralik Cozunlrlak Hassasiyet
1-20" 0.1% +2% + 0.5V
21 -50" 0.1% okunan +0,5V’un 4%

13.8 Yizdelik olarak akimda harmonikler

Yizdelik olarak akimda harmonikler (1’den 50’ye kadar diizen, 50 Hz veya 60 Hz'de minimum gerilim >
20 A. Eger 50HZ'de gerilim OA ise 0% goruntilenir.)

Aralik Cozunlrlak Hassasiyet
1-20" 0.1% +2%
21 -50" 0.1% okunan +2.0%‘nin 4%

13.9 Mutlak deger olarak akimda harmonikler
Yiuzdelik olarak akimda harmonikler (1’den 50’ye kadar diizen, 50 Hz veya 60 Hz'de minimum gerilim >

20 A)
Aralik Cozunurluk Hassasiyet
1-20" 0.1% okunan +0.4%"nin +2%
21 -50" 0.1% okunan +0.4%'nin +4%
13.10 Gug Faktoru
Gug Faktéra (PF)
Aralik Cozunarluk Hassasiyet
>20Vve >20A <20V veya <
20A
0.000 — 1.000 0.001 +0.04 0.1
13.11 Faz agisi
Faz agisi (D)
Aralik Cozunurluk Hassasiyet
-180° - 180° 0.1° +1°
0° - 360° 0.1° +1°

13.12 Dalgalanma hatasi

Dalgalanma hatasi (50 veya 60 Hz'i dikkate alarak THD-F, 50 veya 60 Hz'de minimum deger > 80V ve 20
A, 1’den 50’ye kadar dalgalanmalar. Eger 50Hz veya 60Hz’de gerilim 0 ise 0% gorintilenir.)

Aralik Coziundrluk Hassasiyet
0.0 - 20% 0.1% + 2%
20.1 — 100% 0.1% okunan +1%°nin +6%
100.1 — 999.9 % 0.1% okunan £1%‘nin +10%
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13.13 Akim ve gerilimin en yiksek degerlerin degeri

En yuksek gerilimin degeri (en yiiksek deger > 10V) veya en yiiksek akim (en yiiksek deger > 20A)

Aralik Cozindrluk Hassasiyet
50 Hz 39 us + 5% + 50 Dijit
60 Hz 33 us + 5% + 50 Dijit

Frekans (RMS Deger > 20V) veya ACA (RMS Deger > 30A)
Aralik Cozindrluk Hassasiyet
46 - 65 0.1 +0.3Hz

Sadece i¢ alanlardaki kullanimlar igin!

iletken boyutu:

Pil tara:

Ekran:

Olgtim araligi segimi:

Asir yiklenme gostergesi:

Glg tuketimi:
Otomatik kapanma:
Glncelleme siresi:

yakl. @ 55 mm, 65 x 24mm (Akim Rayi)

2*AA 1.5V

Arka plan aydinlatmali 128 x 64 Matris LCD Ekran
Otomatik

oL

yakl. 10mA

Acildiktan 15 sonra

Saniyede 2 tekrarlama (Ekran)

Olglim tekrarlamanin sayisi: 512 (Gerilim veya Akim)

Calisma sicakhgr:
Maks. hava Nemi:
Depolama sicakhgi:
Depolama nemi:
Boyutlar:

Agirlik:

Ek 6geler:

256 (Gucg)

-10°C’den +50°C’ye kadar
2000 metre’ye kadar
-20°C’den +60°C’ye kadar
75% bagil'dan az

271mm x 112mm x 46mm
647 gr. (Piller dahil)
Olciim iletkenleri

Saklama Cantasi
Kullanim Kilavuzu

Yazilim Kullanim Kilavuzu
Yazilim

Piller AA 1.5V x 2

Timsah Pensi

RS232 — USB Adaptor
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14 Pil degistirme

Pil durumu ekranda goérintilenir.

Pil dolu

Pil bos

Cihazdaki pilleri degistirmek istiyorsaniz asagidaki direktiflere uyunuz:

Cihazi kapatiniz ve élgiim iletkenlerini Olgiim Cihazindan uzaklastiriniz.

Pil kapaginda bulunan vidalari s6kunuz.

Pil kapagini aginiz.

Eski pilleri uzaklastirin.

FUNC tusuna basarak cihazin iginde bulunan son gerilimleri gikartiniz.
Yeni pilleri takiniz.

Pil kapagini tekrar kapatiniz ve vidalari sikiniz.

NogrwNPE

15 Bakim ve temizleme

Kullanim Kilavuzunda tanimlanmamis tamir islemleri sadece kalifiye personeli tarafindan
gerceklestirilebilir.

Olgiim Cihazin gdvdesini sadece nemli bir bez ile temizleyiniz. Asindirici veya ¢dziicii bazli temizlik
maddeleri kullanmayin.
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16 Yazilim

16.1 Sistem gereksinimleri

e Microsoft Windows Vista / XP / 2000(SP3) igletim sistemi ile bilgisayar
e NI-VISA Engine yikli (Yazilimin kurulumunda otomatik olarak yiiklenir)
e Uygun USB-Suriicist yukli (Bolim 2)

16.2 Donanim gereksinimleri
e  Minimum 600MhZ’lik prosesor ile bilgisayar
e Min.: 256 MB RAM, tavsiye edilen: 512MB veya daha fazlasi
o 1024*768 Piksel min. ekran ¢ézunurlugi

16.3 Baglanti kurma

Olgiim Cihazini ve bilgisayari aginiz.

Olgiim Cihazini USB-Kablosu ile bilgisayara baglayiniz.
Gug¢ Analizérin programini baslatiniz.

Cihazin bagh oldugu seri Port'u seginiz.

N

17 Yazilim yukleme

17.1 Program yukleme

Teslimata dahil olan CD’deki setup.exe programini baslatiniz. Bundan sonran yikleme programi
kendiliginden baslar. Ekrandaki talimatlara uyunuz.

Not:
e CD’yi CD-ROM siirticistine koyduktan sonra CD otomatik olarak baslar.
e Program basari ile yiuklendiyse bilgisayariniz yeniden baglatin.

17.2 USB-Sirici yukleme

Bilgisayar Gizerinden CD’yi aginiz ve USB-Sirlcusunt yuklemeniz icin CP210x_VCP_Win2K_XP_S2K3. exe
baslatiniz.

Not:
e Eger donanim taninmamis ise USB-Port’daki fisi ¢cikartin ve tekrar deneyiniz.
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18 Yazilimin kullanimi

18.1 Programin baglatilmasi

Programi baslatmak icin Baslangic = Programlar - CLAMP-ON Graphic Power Quality Analyzer ’e
gidiniz.

Cihazin bagh oldugu Port'u seginiz ve ondan sonra “basmlz.

Hangi Port oldugunu bilmiyorsaniz Cihaz Yoneticisi Gizerinden bakabilirsiniz.

5A Plearse Entor Serial Port Number

Please Enter Serial Port Number

18.2 Ana ekrandaki fonksiyonlar
Yazilimin ana sayfasina gidiniz.

LA CLANY ON Oraphee Prwes Quality Awalyoer r': o @

M

Please select function from menu ...

N |

1. Ara¢ gubugunda (Toolbar) Ayarlama, bilgisayar ve Olgiim Cihazi arasinda iletisim, Olgiim
Cihazindan verilier yikleme, Bilgi ve sonlandirma gibi fonksiyonlar bulabilirsiniz.
2. Sistem Haberleri burda gorunttlenir.

18.3 Parametrelerin ayarlamasi

Ayarlamalara ulagmak igin ara¢ g¢ubugunda File -> Setup tiklayiniz. Programda ayarlamalari
gerceklestirdikten sonra bunlar Olgiim Cihazin hafizasina yazilir.

18.3.1 Saat ve Tarih

i 8]:4
41 tiklayiniz. tiklayarak ayarlamalari devralabilirsiniz.

Tarih ve Saati ayarlamak icin
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18.3.2 Data Logger ayarlan

Olglim tekrarlamalarin (Sample), baslangic ve bitis zamanin (Start Time / Stop Time) ve diyagramdaki
noktalarin sayisinin (Waveform point) ayarlama imkanlari.

18.3.3 Sistem ayarlan

Voltage Transformator (VT), hata gerilimler icin referans gerilimler (TRANS REF) ve onun araligi (%),
Frekans (Hz), Demand Time (MD) ve otomatik kapanma (Auto Power Off) ayarlama imkanlari.

1

5000 %

040 Hz (Aata)
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18.4 Communication/iletigsim

Ekranda iletisime ulasabilmeniz icin ,Communication“ tiklayiniz. Cihaz ile iletisime gegebilmeniz igin
Olciim araligini 3 Phase, 1 Phase, V, A, veya VA getiriniz.

0.629

+ 0,640
1218 -
1.207

Arag¢ cubugunda (Toolbar) istediginiz fonksiyonu secebilirsiniz. Dosyayi a¢ (Open), 6lgiim verilerini kaydet
(Save), dosyayi kapat (Close), Demand Time ve tekrarlama hizi (MD Time & Sample Rate), ekrani yazdir
(Print), grafik olarak goriintilet (Waveform) ve sonlandir (Exit).

Guncel zaman (Current Time), baslangi¢ zamani (Start Time), Voltage Transformator (VT), Frekans (Hz),
Demand Time (MD), Tekrarlama hizi (Sample Rate), kaydedilen verilerin sayisi (Sample Count) ve
glncel hangi 6lcim verisi goruntilensin (Present Sample) sizlere géruntulenir.

18.5 Verilerin yuklenmesi
Olgim Cihazindan verileri yliklemek igin Datalogger - Down Load Data (Strg+D) tiklayiniz.

4 CLAME.ON Omnghar Fower Qrubity Asalyxer

Rl Coommuestion Dekkogper  Help

Download ... (63.5 %)

Reset

Cihazdan ylUzde ka¢ yuUklendigini ekranda gorebilirsiniz.
.Reset‘e tikladiginizda yuklemeyi (Download) durdurabilirsiniz.
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18.6 Hafizayi silme
Verileri silmek igin olan ekrana ulagsmak i¢in Datalogger > Clear Memorz (Strg+C) tiklayiniz.

[ AEE)

File Comumondcation Datalogger Help

Clear Memory 7

Please seledg

Hafizay silmek igin ,Clear Memory*“ tiklayarak islemi onaylayiniz.

Dikkat: Olciim Cihazinda silinmis olan verileri tekrar geri yiiklenemez! Eger veriler lazim ise énce Olgim
Cihazindan yukleyiniz ve bilgisayarda kaydediniz.

19 Cihaz ile iletisim

Yazilim Olgiim Cihazinda hangi verilerin giincel olarak gériintiilendigini gésterir. FUNC tusuna basmaniz
durumunda neyin gdsterilecegini segebilirsiniz.

19.1 lletigsim Ekrani 1

Olclim Cihazindaki Secim Salterini ,3 Phase* veya ,1 Phase® getiriniz ve bundan sonra iletisim Ekrani 1’e
ulasabilmeniz i¢in ,Communication” tiklayiniz.

1. Gorunur Gug (S), Efektif Gug (P) ve Reaktif Gl (Q) gorintusu.
2. Ortalama kaybin ve maksimum azalmanin gorintusu.
3. Gug Faktor (PF), PFF, Faz agisi, PS olarak Gii¢ (HP) goruntusa.
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19.2 lletisim Ekram 2
Olctim Cihazindaki Secim Salterini ,V* getiriniz ve bundan sonra iletisim Ekrani 2’ye ulasabilmeniz igin
»~Communication® tiklayiniz.

| 111.2
4

7 158.8

1 2.2
3
B
_7\1
,T 111.2
B o | i Lo

Gerilim egrisinin goruntusu

Amplitid Spektrumun goruntusu

Dalgalarin (segilebilir) gorintisi

RMS, en yiiksek (Peak) ve THD gibi giincel degerlerin gérintiisi
Glg ve yizdelik oranin gorintis

agrwNE

19.3 lletigim Ekrani 3

Olglim Cihazindaki Secim Salterini ,VA* getiriniz ve bundan sonra iletisim Ekrani 3’e ulasabilmeniz igin
»~Communication® tiklayiniz. Akim ve gerilim 6lgimuini gerceklestirdikten sonra ekranda asagidaki resim
gorantalenir:

846.7

™ 4.462
Y .
28.5

1. Gerilim dzelliklerin géruntusi
2. Guncel RMS- ve en ylksek (Peak) degerin gorintisu
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19.4 lletisim Ekrani 4

Olglim Cihazindaki Secim Salterini ,VA* getiriniz ve bundan sonra lletisim Ekrani 4’e ulasabilmeniz igin
~Communication® tiklayiniz. Gerilim 6lgimini gergeklestirdikten sonra ekranda asagidaki resim

goruntulenir:

.

110.9

1 : 7~ 1581

1. Gerilim dzelliklerin géruntusi
2. Gincel RMS- ve en yiksek (Peak) degerin goruntisu

19.5 Olcum verilerini agma ve kaydetme
iletisim Ekranlarindan veriler veya Olciim Cihazindan yiiklenmis élgiim verilerini kaydedebilirsiniz.
Bunun icin: File > Save (Strg+S) tiklayini — gtincel veriler .csv-Dosyasina kaydedilir.

19.6 MD siiresinin ve tekrarlama hizinin ayarlamasi
File > MD Time & Sample Rate’e tiklayiniz ve ondan sonra ,Setting“ tiklayiniz.
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Ekranda asagidaki pencere acilir:

4 Plonse Enter MD Time & Sample Rate

Simdi parametreleri degistirme imkanina sahipsiniz. Enter'e basarak ayarlamalari onaylayabilirsiniz.
Dikkat: Kaydedilen veriler onaylama iglemi ile kaybolur. MD Suresini ve tekrarlama hizini degistirmeden
once verileri kaydediniz.

19.7 Yazicinin segimi
File = Print tiklayiniz. Bundan sonra ,\/” basarak ilgili yaziciyi seginiz.

Print

WPCVHE Color Laserlet 2500 N

Cancel Apply

19.8 Dalgaformu
iletisim Ekraninda ,Waveform* tiklayiniz ve isteginiz formu segin.

Kommunikationsbildschirm | 'V, A'S, P, Q, PF, Phase, KVAH, KWH,
KVARH, PFH, VA(AD), W(AD),
VA(MD), W(MD)

Kommunikationsbildschirm I . RMS, Peak, THD

Kommunikationsbildschirm I : V, A, P, S, Phase

Kommunikationsbildschirm IV : RMS, Peak
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19.9 Dalga formunu giincellestirme

+~Waveform-Ekraninda“ 6lgim dederlerini daha detayli bir sekilde inceleyebilmeniz icin manuel olarak
Olgegi ve kirsoér pozisyonunu degistirebilirsiniz. Bu islemi yanlishkla gergeklestirmis olmaniz durumunda
komple dalgalanma formuna geri dénmek icin File - Redraw tiklayiniz ve dalga formu tekrar
goruntdlenir.

—— M [V, " e -

13358y 191
ouoeet

Guncel kursoér pozsiyonun degeri

Secilmis grafiklerin gorintisi

Gincel klrsor pozisyonun degistiriimesi

incelemek istediginiz araligin kaydiriimasi igin dlgege tiklayiniz

PN PE

19.10 Dalgalanma formunu yazdirma
File = Print tiklayarak glincel goriintilenen dalgalanma formunu yazdirabilirsiniz.

19.11 Calisma Modlari

Real Time Modu: Guncel verileri iletisim Ekraninda gériintiler.
History Modu: Onceden kaydedilmis verileri incelemek icin. Hala veriler kaydedilir.
File Modu: Bilgisayarda kaydedilmis 6l¢gim verilerini agar.
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19.12 Calisma Modlarin sifirlanmasi (Reset)

View > Reset tiklayiniz. Gilincel olarak gorintilenen veriler ekrandan silinir ve yazilm Real Time
Moduna gecer.

UJ Commmnmntonn

R Weniom RS

1. Calisma Modun secimi ve galisma modun sifirlanmasi (Reset)
2. Gincel goruntilenen olgim degerlerin segimi (sadece History Modunda yapilabilir)
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20 Geri donlisum

Toksik olmalarindan dolayi piller, ev tlrG atiklarla birlikte atilamazlar. Geri dénidsim igin pil toplama
noktalarina birakmalidir.

Pil toplama noktasi:

PCE Teknik Cihazlar Ltd. $ti.
Halkali Merkez Mah

Ataman Sok. No.:4/4

Cihazdan diizglin bir sekilde kurtulmak igin bize gdnderebilirsiniz. Cihazin pargalarini degerlendirebiliriz
ya da cihaz, mevcut diizenlemelere uygun olarak bir geri donliisiim sirketine génderilir.

21 iletisim

Eger Grlin yelpazemiz veya Olgim cihazi ile ilgili sorulariniz olursa PCE Teknik Cihazlar ile irtibata
geginiz.

Posta:

PCE Teknik Cihazlan Ltd. Sti.
Halkali Merkez Mah

Ataman Sok. No.:4/4

Telefon:
0212 471 11 47
0212 705 53 93

WEEE-Reg.-Nr.DE69278128 E @ c € %

www.pce-cihazlari.com.tr
Butin PCE Uraniern CE ve RoHs
sertifikahidir
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